
This document is classified as commercial-in-confidence. Unauthorised distribution of this information may constitute a breach of our Code of Conduct, and may infringe our intellectual property rights. This 
information is collected and managed in accordance with our Privacy Policy, available on our website at https://bpsoftware.net/privacy-policy 

Version: 2.0 

J A D E  T O  S A F F R O  N  S  P 3

U P G R A D E
G U I D E  

Stay on course 
with Saffron SP3!



Legal notices

This document is classified as commercial-in-confidence. Unauthorised distribution of this information may con-
stitute a breach of our Code of Conduct, and may infringe our intellectual property rights. This information is col-
lected and managed in accordance with our Privacy Policy, available on our website.

© Copyright 2022

Best Practice Software believe the information in this User Manual is accurate as of its publication date. The inform-
ation is subject to change without notice.

You may only copy, change, or use the User Manual as required for your own use as permitted under the End User
Licence Agreement or the Order Form. User Manuals are intended for reference only and do not preclude the need
for training.

Best Practice Software Pty Ltd
PO Box 1911
Bundaberg Queensland Australia 4670

Best Practice Software New Zealand Ltd
PO Box 1459
Hamilton New Zealand 3240

www.bpsoftware.net

The information contained in the User Manual is intended to be a guide only. BPS does not provide any warranty in
relation to its currency, accuracy or completeness and, unless otherwise required by law, will not accept any liability
in relation to any loss or damage suffered by you or any third party in reliance on the information contained in the
User Manual.

Last updated: 04 March 2022

Intended for usage with Bp Premier version Saffron SP3 and later. Some features in this User Manual may be avail-
able only in versions later than Saffron SP3.

Document Title: Jade to Saffron SP3 Upgrade Guide Version: Saffron SP3
Last Amended: 04 March 2022 Page | 2

https://bpsoftware.net/privacy-policy/
https://bpsoftware.net/


Table of contents

Bp Premier Jade to Saffron SP3 Upgrade Guide 1
Table of contents 3
About this Guide 4
If you are upgrading from Summit 4
Information for IT service providers and practice managers 4
System requirements 4
End of extended support 5
Steps to upgrade 6

Before you upgrade 6
Upgrade 7
After you upgrade 7

Permissions, preferences and configuration settings 8
New user permissions 8
New user preferences 9
New configuration settings 9

Abbreviations 12
Legend 13
What you’ve missed 13
Features 15

Jade SP1 15
Jade SP2 15
Jade SP3 16
Jade SP4 18
Saffron 19
Saffron SP1 23
Saffron SP2 25
Saffron SP2 Rev1 28
Saffron SP3 28

Document Title: Jade to Saffron SP3 Upgrade Guide Version: Saffron SP3
Last Amended: 04 March 2022 Page | 3



About this Guide
This guide summarises the activities required to upgrade from any version of Bp Premier Summit or later to Saffron SP3. If you are upgrading from versions Sum-
mit, Lava, or Indigo, or Jade, you will need to note updated system requirements. Use this brief guide in conjunction with the full Bp Premier Saffron SP3 Upgrade
Guide.

To view the version you are on, select Help > About in Bp Premier.

If you are upgrading from Summit
Version Lava introduced adjustments, deposits, and write-offs to the management module, and new management reports to accommodate the database changes.
Best Practice Software strongly recommend upgrading at the end of a disbursement or financial reporting period. The new management reports cannot be run on
financial data recorded before the upgrade.

If you are running version Lava, Indigo, or Jade, you can upgrade at any time outside of normal practice hours.

Information for IT service providers and practice managers
Large practices that have to upgrade multiple workstations can take advantage of Bp Premier silent installations. Instead of running the upgrade through the
upgrade wizard, you create a configuration file, deploy the file to all upgrading computers, and run from the command line.

IMPORTANT Silent installations require experience with Windows batch files, the command line, and access to the C:\ drive.

System requirements
As of February 2022, system requirements for Bp Premier are:
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Microsoft Windows

Version Windows 8 Windows 8.1 Windows 10 Windows 11

Saffron SP3

See note

NOTE Saffron SP3 can run on Windows 8.1, however, you must install this Windows 8.1 update before installing or upgrading to Saffron SP3.

Microsoft Windows Server

Version Windows Server 2008 R2 SP1 Windows Server 2012 Windows Server 2012 R2 Windows Server 2016 Windows Server 2019 Windows Server 2022

Saffron
SP3

Microsoft SQL Server

Version SQL Server 2008 R2 SQLServer 2012 SQL Server 2014 SQL Server 2016 SQL Server 2017 SQL Server 2019

Saffron SP3

End of extended support
In 2017, Microsoft ended extended support for Windows XP, Windows Server 2003, and SQL Server 2005. In January 2020, Microsoft ended extended support for
Windows 7, Windows Server 2008, and SQL Server 2008.
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If you are running Bp Premier on an operating system or SQL Server version no longer supported by Microsoft, Best Practice Software strongly recommend 
upgrading before you upgrade to Bp Premier Saffron SP3. Your instance of Bp Premier will continue to run on unsupported versions. However, your operating 
system and database will no longer be receiving security patches or general updates from Microsoft.

This knowledge base article contains instructions on upgrading your version or edition of SQL Server. This Microsoft Support article provides more information on 
the Microsoft product lifecycle and extended support.

Steps to upgrade

Before you upgrade

Step Upgrade item

1. If you have not yet done so in Saffron SP2, connect to Medicare Web Services. You must connect to Medicare Web Services to use patient verification, online claiming
and AIR functionality in Saffron SP3.

2. Back up your Bp Premier database. Best Practice Software also recommend testing that the backup restores successfully to a test (trial) server

3. Synchronise any remote laptops with the Bp Premier database and log out.

4. Log all users out of the server and all workstations

5. Download the Saffron SP3 upgrade file and copy the file to the Bp Premier server and all workstations (remote and local), ready to run.

6. Review the Saffron SP3 Release Notes.

7. Download the most recent Data Update to the Bp Premier server and run the Data Update. If you have automatic Data Updates set up, you will already be up to date.

NOTE If you have installed the data update immediately prior to the most recent, you only need to install the incremental data update. If you are more than a month
behind, install the comprehensive data update. If you have gone some time without running a data update, you may be asked to install an interim data update before
you are able to install the most recent.
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Upgrade

Step Upgrade item

1. Run the upgrade file on the Bp Premier server first. Select the 'Server' option at the start of upgrade. See this knowledge base article for more information.

2. At the end of the upgrade, the Upgrade Wizard will show the Setup third-party integrations panel. Select any database integrations that your practice uses and proceed
with the upgrade. This knowledge base article provides more information on the Bp Partner Network.

If you are running a silent install, after the upgrade is complete, go to Configuration > Setup > Database > Setup third-party integrations and select the database
integrations for your practice.

3. Run the upgrade on each workstation immediately after the server upgrade. Select the 'Client' option at the start of upgrade.

IMPORTANT Workstations that are not upgraded will be unable to access new features and may not be able to connect to the server.

After you upgrade

Step Upgrade item

1. If you have not already done so in Saffron SP2, register a B2B device via the PRODA tab in Setup > Configuration.

2. If your practice links to billing software, or exchanges files between Bp Premier and other software, check that the linking is working as expected after the upgrade.

3. If you did not select database integrations to enable during the upgrade process, go to Setup > Database > Setup third-party integrations, select the database
integrations for your practice, and click OK.

IMPORTANT All legacy database integrations, such as the BPSAppointments account, are disabled after upgrade to Saffron. Youmust enable the partner specific
role for any third-party integrations your practice uses after upgrading, or these integrations will cease to function.
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Step Upgrade item

4. SelectManagement > Reports to view all of the reports added in the latest program and data updates. You will have to grant access to any new reports to users that will
be running those reports. Cloning another user's reports will make this process easier. This knowledge base article explains how.

5. Review the new user permissions and user preferences described in the following tables. You will need to update your users' permissions to control access to new
features. New permissions are normally disabled by default.

6. Review the Known Issues for Saffron SP3 to see all issues resolved since Summit and any outstanding issues

Permissions, preferences and configuration settings

New user permissions

The following user permissions for new functionality have been added since Summit. Set permissions from Setup > Users > Edit > Set permissions. This knowledge
base article provides more information about user permissions.

Permission Description

Clinical Notes - Add / Edit Restricts ability to delete clinical notes.

Bp Backup Restricts ability to access the backup function

BDI Restricts access to Bulk Document Importer. Previously controlled by Correspondence In.

HealthLink Restricts access to HealthLink forms.

Printers Restricts access to printer configuration.

Word Processor - Allow Clinical
access

New option to allow access to clinical data in the Word Processor. The 'Allow' access level now restricts the user to non-clinical data only.
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Permission Description

Subpoena Tool Restricts access to the Subpoena Tool function.

Send Bp Comms Messages Previously called 'Send SMS Messages'. Now restricts access to all Bp Comms messages.

Prescribe on behalf of Restricts ability to nominate another provider to prescribe on behalf of in the New Rx function.

Medicare refunds Restricts access to Medicare refund functionality.

PRODA setup Restricts access to the PRODA section in Setup > Configuration.

New user preferences

The following user preferences have been added since Summit. Set user preferences from Setup > Preferences. This knowledge base article provides more inform-
ation about user preferences.

Preference Description

Clinical > Usual visit type Set the Default Visit type.

Letters > Default address book Set the default online directory to use (HealthLink, HealthShare, or local contacts).

Prescribing > Enable real-time prescription monitoring Enable real-time prescription monitoring for this provider.

General > Resize patient photo if larger than Resize a patient photo if larger than the specified dimensions.

Clone You can now clone the preferences of an existing user.

General > Enable NCSR functionality Set National Cancer Screening Register (NCSR) use at an individual level.

New configuration settings

The following configuration settings have been added since Summit. You may need to turn on settings to access new functionality in Setup > Configuration.
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Configuration Option Description

Billing > Check the Credit Payments box when
reversing payments

Sets the default for the Credit payments... checkbox when payments are reversed, indicating how refunds should be credited.
This knowledge base article provides more information.

Appointments > Show Invoiced and Paid Status Displays appointments with the new Invoiced and Paid statuses. This knowledge base article explains the appointment book
statuses.

Appointments > Display record number on
appointment

Displays the patient's record number in bookings

Reminders > Reminder reason > Clinically
significant

Indicates the reminder is clinically significant. This knowledge base article explains what this option might mean for your
practice.

Bp Comms New tab for setting up Bp Comms messaging. Previously SMS reminders were set up from the Appointments tab.

Appointment Reminders > Configure replies Can now specify custom reply messages instead of the default 'Yes' or 'No'. This knowledge base article describes how.

Msg Queue New tab for setting up the Bp Messaging Service, required for Bp Comms.

Database > Backup drug database at the end of
a data update

Backs up the drug database automatically after running a monthly data update. This knowledge base article provides more
information.

Templates New tab for the maintenance of all message templates. This knowledge base article describes how to set up Bp Comms
templates.

Bp Service New tab for managing Bp Service, which replaced Bp Link in version Lava. This knowledge base article provides more
information on switching to Bp Service for practices running older versions.

FHIR New tab for managing third party access to Bp Premier via FHIR. This knowledge base article provides more information on
FHIR connections.
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Configuration Option Description

General > Enable National Cancer Screening
Registry Integration

Allows users to download the National Cancer Screening Registry (NCSR) integration. This knowledge base article provides
more information in setting up NCSR integration

Security New tab for configuring security settings. This knowledge base article describes the new security settings available

General > Enable ePrescriptions Enables the use of electronic prescriptions, or eScripts, at the practice. This knowledge base article provides more information
about setting up eScripts.

General > Online Directory for Contacts, Online
Directory for Messaging Provider

Online Directory for contacts enables an online directory to be selected. Online Directory Messaging Provider enables a
messaging provider to use when sending messages to members of the online directory to be selected. This knowledge base
article provides more information.

General > Import certificates New drop-down menu for selecting a location to import a NASH certificate for. This knowledge base article provides more
information.

General > Max document database size New drop down menu for selecting the Max document database size. This knowledge base article provides more information.

PRODA New tab for managing connection to Medicare Web Services via PRODA. This knowledge base article provides more
information.

Bp Service > Use Bp Service for automatically
deploying the data update.

Select this option and click Configure Data Update to set up data updates to download and apply automatically. This
knowledge base article provides more information.

Lists > Configure visit types You can now remove items from the visit types list. This knowledge base article provides more information.
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Abbreviations

Abbreviation Meaning

ABN Australian Business Number

ADHA Australian Digital Health Agency

AIP Active ingredient prescribing

API Application Programming Interface

App Application

ASL Active Script List

BHA Best Health App

BMI Body Mass Index

Bp Best Practice

CST Cervical Screening Test

DVA Department of Veteran Affairs

eScript Electronic Prescription

FHIR R4 Fast Healthcare Interoperability Resources (Release 4)

GBR Guidance-based requests

HL7 Health Level Seven

HPV Human papillomavirus

KB Knowledge Base

LBC Liquid Based Cytology

MBS Medicare Benefits Schedule

MC Masterclass

NASH National Authentication Service for Health

NCSR National Cancer Screening Register

NDE National Data Exchange

NIP National Immunisation Program

ORU Observation Result
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Abbreviation Meaning

PBS Pharmaceutical Benefits Scheme

QRG Quick Reference Guide

Rx Medical prescription

S8 Schedule 8 drugs - Drugs of addiction

SP Service Pack (i.e., SP1 – Service Pack 1)

XML Extensible Markup Language (file)

Legend
For ease of use, release information has been categorised under the following groupings to help you to identify the
nature of the content. We’ve also included links to various resources throughout the Guide that will provide you with
more information about the feature, function or workflow described.

Using the legend below, you can tell at a glance the nature of the release information and what type of resources are
available on a particular topic.

Icon Description

Release information

Workflow changes:Major workflow changes that, in many cases, must be incorporated or at least considered
once using new version.

Watch-outs for staff: Not necessarily a change of workflow but things that might throw staff off, such as
warnings or new prompts that should be addressed in staff education.

Quick wins: New features or updates that require little change management to incorporate - some nice added
bonuses.

Long term benefits New features or updates that offer significant strategic and/or procedural benefit but
would likely require a planned change process.

What you’ve missed
At Best Practice we are continuously working to improve our products and bring you the latest features and func-
tionality that technology has to offer. While we go into the details of each release in the next section, here’s a sum-
mary of the releases you missed since your purchase/install of Bp Premier:
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Release version Release date Release resources

JADE SP1 September 2019 Release notes (PDF)

Jade SP1 - Navigating Best Health, an introduction to Bp's new Patient App (Video)
[39:17]

Jade SP1 - Patient Communication using Bp Comms Video [54:56]

JADE SP2 December 2019 Release notes (PDF)

JADE SP3 July 2020 Release notes (PDF)

Jade SP3 - Introducing Electronic Prescribing Video [54:25]

JADE SP4 October 2020 Release notes (PDF)

SAFFRON January 2021 Release notes (PDF)

Saffron Series - Secure Messaging Video [11:25]

Saffron Series - Management Reports Video [02:13]

Saffron Series - Bp Comms for Clinical Only Video [04:22]

Saffron Series - Next Phase ePrescribing Video [16:49]

Saffron Series - NCSR Video [11:21]

Saffron Series - Medicare Refunds Video [11:25]

Saffron Series - Active Ingredient Prescribing Video [04:42]

SAFFRON SP1 June 2021 Release notes (PDF)

SAFFRON SP2 October 2021 Release notes (PDF)

SAFFRON SP2
REV1

November 2021 Release notes (PDF)

SAFFRON SP3 March 2022 What's new in Bp Premier (KB article)

IMPORTANT The good news is that by upgrading, you will have access to ALL the new features, functions and
workflows included in the each of these release versions.
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Features

Jade SP1

New Jade SP1 features are comprised of updates to Clinical Reminders, Follow Up Reminders and Inbox and Follow
Up Inbox functionality.

Category Feature Who it affects / Resources

Activation of the Best Health App. Practice managers Admin/Reception

Clinicians IT

Best Health App Masterclass FAQ (KB article)

Jade SP1 - Patient Communication using Bp Comms
(Masterclass video)

Jade SP1 - Navigating Best Health, an introduction to Bp's
new Patient App (Masterclass video)

Improved filtering options in the Contact Notes
list and Follow up reminders screens, as well as
the Follow Up Inbox.

Practice managers Admin/Reception

Clinicians IT

Time taken to download the Bp Premier
database to a laptop for remote use greatly
decreased (now takes minutes rather than
hours).

Practice managers Admin/Reception

Clinicians IT

Download the Bp Premier database for remote use (KB
article)

Enhanced links between Clinical Reminders and
Contact Notes. All contact attempts for a
reminder can be viewed in one list.

Practice managers Admin/Reception

Clinicians IT

Follow up sent reminders (KB article)

Jade SP2

Jade SP2 includes changes to memory handling, the Online Claiming Workflow and Gender Identity fields.
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Category Feature Who it affects / Resources

Third party software integrators that are not
part of the Bp Partner Network will cease to
function

Practice managers Admin/Reception

Clinicians IT

Bp partner network (Best Practice Software website)

Best Practice Software Partner Network (KB article)

New help menu option to connect to remote
assistance for software support added.

Practice managers Admin/Reception

Clinicians IT

Data lock added to the Online Claiming module.
Only one user at a practice can check for
payments at a time, improving data integrity.

Practice managers Admin/Reception

Clinicians IT

Some functions re-engineered to improve
memory usage and performance. This means
that additional logins are required for some
system tasks, such as the Subpoena Tool.

Practice managers Admin/Reception

Clinicians IT

Nutrition Plus education fact sheets added to
Patient Education materials.

Practice managers Admin/Reception

Clinicians IT

More options available in the patient
demographic to help identify patients of varying
gender identities.

Practice managers Admin/Reception

Clinicians IT

Jade SP2 Birth Sex, Gender Identity and Pronoun FAQ (KB
article)

Recording Birth Sex, Gender Identity, and Pronouns (QRG
PDF)

Ability to specify that a patient has opted out of
de-identified data extraction added.

Practice managers Admin/Reception

Clinicians IT

Better memory handling in the Follow up Inbox,
Appointment Book, and Clinical Reminders
improving overall system performance.

Practice managers Admin/Reception

Clinicians IT

Jade SP3

Electronic Prescribing is introduced in Jade SP3. Electronic Prescription tokens can now be sent to patients via email
or SMS, or in paper form. User password and permission changes will also be logged from in the Auditing function,
and viewable to users with the user permission View security audit.
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Category Feature Who it affects / Resources

Electronic Prescribing:

new 'eScripts' functionality allows your prac-
tice to use token method to send electronic
scripts to patients.
Clinicians will be prompted for password for
each separate instance of prescribing an S8
Rx.

Practice managers Admin/Reception

Clinicians IT

JADE SP3 - Introducing Electronic Prescribing (Masterclass)

Set up electronic prescribing (KB article)

Electronic Prescribing (KB article)

Frequently asked questions about electronic prescribing (KB
article)

Frequently Asked Questions from our eScripts Masterclasses
(KB article)

Electronic Prescribing (QRG PDF)

Prescribing:

the Repeat interval field now defaults to
blank, so a value must be entered when pre-
scribing S8 drugs.
for Tasmanian based practices, the dose win-
dow in the New Rx wizard will include a
checkbox for Unusual Dose.

Practice managers Admin/Reception

Clinicians IT

Security auditing – the User Logins screen has
been renamed to Security Audit. This will be the
central location for future enhancements to
security auditing.

Practice managers Admin/Reception

Clinicians IT

Audit record changes and user activity ( KB article)

Electronic Prescribing – PBS code for
extemporaneous compounding medicines is
now supplied with the eScript for prescriptions
of this type.

Practice managers Admin/Reception

Clinicians IT

Patient record – Fields for Loss of taste and Loss
of smell have been added to the General page of
the History & Examination window.

Practice managers Admin/Reception

Clinicians IT

eRx – To help reduce dispenser error, the
‘ItemTradeName’ XML field now includes
product name and description when sending via
eRx.

Practice managers Admin/Reception

Clinicians IT

MBS updates – From this release, MBS Referral
and Attendance Groups will be updated in Data
Updates and no longer require a Program
Update to be updated.

Practice managers Admin/Reception

Clinicians IT
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Category Feature Who it affects / Resources

GBR – For practices with GBR enabled and
requesting from a GBR lab, the CST Details
window will open pre-populated with
information from the clinical record, if the
'Cervical/Vaginal screening' context and a
relevant additional test is ticked.

Practice managers Admin/Reception

Clinicians IT

Results imports – When importing an ORU file,
the OBR-13 segment is now displayed in new
imported results as ‘Clinical notes’.

Practice managers Admin/Reception

Clinicians IT

Immunisation – Schedule changes to the
National Immunisation Program (NIP) included,
effective from 1 July 2020.

Practice managers Admin/Reception

Clinicians IT

Online claiming – Items 99 and 104 paid
correctly when claimed together. Processing
Item 288 with other psychiatrist items (e.g., 296,
306, 302, 291, 348, 352) also fixed.

Practice managers Admin/Reception

Clinicians IT

Security auditing – User permission changes,
including a provider's prescribing permission,
are logged and viewable from the Security Audit
screen.

Practice managers Admin/Reception

Clinicians IT

End of Extended Support – Microsoft ended
extended support for Windows 7, Windows
Server 2008, and SQL Server 2008 in Jan’20.
These components should be upgraded before
upgrading to Jade SP3, otherwise your operating
system and database will no longer receive
security patches or general updates from
Microsoft.

Practice managers Admin/Reception

Clinicians IT

Jade SP4

Jade SP4 was a minor release containing COVID-19 billing adjustments.

Category Feature Who it affects / Resources

Medicare billing – COVID-19 incentives are no
longer populated after running the October
2020 Data Update and the service date is before
20/04/2020, or on or after 01/10/2020.

Practice managers Admin/Reception

Clinicians IT
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Category Feature Who it affects / Resources

Medicare billing – In accordance with telehealth
billing, changes effective 1 October 2020
include:

‘At risk of COVID-19’ checkbox no longer
appears in the Finalise billing screen at end
of consult.
A custom schedule for billing patient can be
selected and the COVID prompt no longer
appears when Store/Print is selected.
10981/10982 can be backdated prior to 1
October 2020 and can be billed separately.
10990/10991 appears if bulk billing incentive
applies to the patient.

Practice managers Admin/Reception

Clinicians IT

Telehealth DVA – MT88/MT89 continues to be
applied to the patient invoice when claiming
telehealth items on the DVA schedule.

Practice managers Admin/Reception

Clinicians IT

Prescribing – Ritalin LA capsules now show
correct dose description in the Authority item.

Practice managers Admin/Reception

Clinicians IT

GBR – When ordering GBR pathology, the ‘Use
again’ function puts the correct test name into
the eOrder message.

Practice managers Admin/Reception

Clinicians IT

Saffron

The Saffron release comprises a raft of new initiatives and features, including the next phase of Electronic Pre-
scribing, Secure Messaging, National Cancer Screening Register integration, Medicare refunds and more.

Category Feature Who it affects / Resources

Medicare Refunds > Online claiming – A new
Refund/Adjust Payment screen is available to
handle whole refunds of Medicare payments.

Practice managers Admin/Reception

Clinicians IT

Medicare Refunds (Saffron Series MC)

Medicare Refunds (KB article)

AIP - Active ingredient prescribing introduced Practice managers Admin/Reception

Clinicians IT

Understanding Active Ingredient Prescribing (KB article) 

Active ingredient prescribing (Saffron Series MC)
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Category Feature Who it affects / Resources

Medicare Refunds > User permissions – A new
user permission now controls access to the
Medicare refunds function.

Practice managers Admin/Reception

Clinicians IT

Prescribing > Remote download – Only the
password security settings password lockout
period, number of login attempts, and password
complexity remain in effect when in remote
download mode.

Practice managers Admin/Reception

Clinicians IT

Other > Bp Comms and Licencing – Sending
messages to SMS and Best Health App (BHA) are
now available for sites with a Clinical-only
licence. Clinical-only sites will be able to use all
electronic prescribing sending methods after
upgrading to Saffron.

Practice managers Admin/Reception

Clinicians IT

Bp Comms for clinical in Saffron (KB article)

Bp Comms for Clinical Only (Saffron Series MC)

Security – New Security tab in Setup >
Configuration controls password security
options. 

minimum password length
enforced lockout timeout from failed login
attempts
enforced inactivity timeout and account lock
when using eScript functionality
enforced creation of a new password after a
set time
enforced password reuse time limit
passwords checked for compliance with pass-
word security settings
maximum password length increased to 20
characters
enforced password complexity, while case
sensitivity enforced when logging in if
'Strong' enabled.

Practice managers Admin/Reception

Clinicians IT

Manage Password and access security (KB article)

Password security QRG (QRG PDF)

Secure Messaging – An alert will appear if the
intended recipient of a secure message cannot
accept the HL7 version.

Practice managers Admin/Reception

Clinicians IT

Secure messaging (Saffron Series MC)

Prescribing > eScripts – Maximum quantity
authorised to dispense included when
prescribing controlled drugs via eScript.

Practice managers Admin/Reception

Clinicians IT

Next Phase electronic prescribing (Saffron Series MC)
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Category Feature Who it affects / Resources

Prescribing > eScripts – Authorisation reference
number included when prescribing controlled
drugs via eScript. Label corresponds to the state
of issue (e.g., “Approval number” in QLD and
ACT).

Practice managers Admin/Reception

Clinicians IT

Prescribing > eScripts – Revalidation prompt
checks for password security compliance when
prescribing controlled drugs via eScript.

Practice managers Admin/Reception

Clinicians IT

AIP – No NDE pre-check is performed when
prescribing a custom preparation, regardless of
whether a monitored drug has been added as an
ingredient.

Practice managers Admin/Reception

Clinicians IT

Secure Messaging > Certificate Validation –
Impending NASH certificate expiry alerted to
Principal Doctor and Practice Manager on login.

Practice managers Admin/Reception

Clinicians IT

Applying for a NASH PKI certificate (Services Australia
website)

Secure Messaging > Messaging Configuration –
New drop-down list added to Online Directory
Messaging Provider to record the messaging
provider used for when a FHIR R4 compliant
online directory is chosen.

Practice managers Admin/Reception

Clinicians IT

Secure Messaging > Messaging Configuration –
New button and pop-up screen (Configure
Sending Facility) added to configure your
practice as an endpoint in the secure messaging
chain.

Practice managers Admin/Reception

Clinicians IT

Secure Messaging > Online directories – Search
by suburb and postcode enabled in online
directories.

Practice managers Admin/Reception

Clinicians IT

Secure Messaging > Online directories – Local
contacts access the most up-to-date details
from the online directory when addressing a
synchronised contact.

Practice managers Admin/Reception

Clinicians IT

Secure Messaging > Results acknowledgement
– HL7 acknowledgements updated to support
conformant HL7 2.4 standard.

Practice managers Admin/Reception

Clinicians IT

Send and follow up eReferrals (KB article)
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Category Feature Who it affects / Resources

Secure Messaging > Results acknowledgement
– Scheduled tasks run daily to identify sent
messages not acknowledged or have received a
negative acknowledgement.

Practice managers Admin/Reception

Clinicians IT

Set up results acknowledgement and notifications (KB article)

Secure Messaging – Letters now sent via HL7
2.4 with a PDF display segment when a
compatible online directory and recipient
chosen.

Practice managers Admin/Reception

Clinicians IT

Secure Messaging > Medicare certificates –
Dual NASH SHA-1 certificate detected if a site
imports a certificate with a policy number of
1.10.1.1, disabling the Medicare radio button in
the import certificate utility.

Practice managers Admin/Reception

Clinicians IT

Medicare Refunds > Report – Management
Reports show service adjustments as ‘Written
off’ and payment adjustments with a status of
‘Medicare or DVA refund’.

Practice managers Admin/Reception

Clinicians IT

Management reports (Saffron Series MC)

Prescribing > Contact notes – New contact note
reason 'eScript Token' added and will
automatically be created when an eScript is
prescribed.

Practice managers Admin/Reception

Clinicians IT

Prescribing > eScripts

tokens can be sent via BHA or SMS, Bp
Comms credits required.
eScripts can be resent via BHA or SMS
eScripts sent via Bp Comms to patients
instead of eRx.

Practice managers Admin/Reception

Clinicians IT

Prescribing – Both quantity (no. of units) and
unit size (e.g., 30 grams) sent to eRx when
prescribing a cream or similar type of drug.

Practice managers Admin/Reception

Clinicians IT

Prescribing > RTPM – Medications checked
against NDE when sent if Real-time prescription
monitoring is enabled..

Practice managers Admin/Reception

Clinicians IT

Real Time prescription monitoring (KB article)

Prescribing > Utilities – Bp Utilities updated to
handle new password security parameters.

Practice managers Admin/Reception

Clinicians IT
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Category Feature Who it affects / Resources

Other > Auditing – Bp Utilities > Security audit
can be exported as CSV document containing
data on screen according to selected filters.

Practice managers Admin/Reception

Clinicians IT

Other > Installation – SQL Server 2019 an option
for new installations of Bp Premier Saffron.

Practice managers Admin/Reception

Clinicians IT

Other > Patient Demographics –'Practice nurse'
users can be selected as a patient's Usual
Doctor in demographics.

Practice managers Admin/Reception

Clinicians IT

Prescribing – ‘Consent to Upload to ASL’
checkbox added to Add/Edit Rx workflow to
indicate that Rx will be uploaded to the patient's
ASL.

Practice managers Admin/Reception

Clinicians IT

Prescribing > RTPM – ‘Enable real-time
prescription monitoring’ checkbox available in
user preferences for all Australian states. NB:
RTPM is currently available in Victoria only.

Practice managers Admin/Reception

Clinicians IT

NCSR > FHIR – New ‘FHIR’ tab added to Setup >
Configuration for setting FHIR permissions for
FHIR-enabled vendors.

Practice managers Admin/Reception

Clinicians IT

Set up a FHIR connection (KB article)

NCSR – NCSR integration enabled for practice in
Configuration and for provider in User
preferences.

Practice managers Admin/Reception

Clinicians IT

Set up NCSR Integration (KB article)

NCSR – Open NCSR Hub from the patient clinical
record.

Practice managers Admin/Reception

Clinicians IT

Using the NCSR Hub (KB article)

Saffron SP1

Saffron SP1 includes a number of workflow changes and enhancements, such as changes to the way e-ordering is set
up, further improvements to Medicare refunds, and more.
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Category Feature Who it affects / Resources

E-Ordering – set up is now organised in a new
screen accessed via View > Contacts > Setup >
E-Ordering.

Practice managers Admin/Reception

Clinicians IT

Set up pathology e-ordering in Saffron SP1 (KB article)

Set up imaging e-ordering in Saffron SP1 (KB article)

Add Rx - The ‘Allow brand substitution’
checkbox is now opt-out rather than opt-in.

Practice managers Admin/Reception

Clinicians IT

Add or cease Rx (KB article)

Acknowledgements – the set up process for
acknowledgements has changed.

Practice managers Admin/Reception

Clinicians IT

Set up a messaging provider (KB article)

Electronic Prescribing – a new ‘Verify eScript’
screen will appear when sending electronic
prescriptions.

Practice managers Admin/Reception

Clinicians IT

Electronic Prescribing (KB article)

IHI Validation - when a patient's Medicare or
DVA number changes, you will be prompted to
revalidate their IHI number.

Practice managers Admin/Reception

Clinicians IT

Patient Health Identifier validation (KB article)

E-Ordering – an alert will appear when using the
old e-ordering setup workflow indicating that
the new workflow should be used.

Practice managers Admin/Reception

Clinicians IT

Set Up Pathology and Imaging E-Ordering in Saffron (KB
article)

Electronic prescribing – when creating a new
user with prescribing capability, an alert appears
if they are not correctly set up for electronic
prescribing.

Practice managers Admin/Reception

Clinicians IT

Electronic Prescribing (KB article)

Electronic Prescribing – an alert appears when
attempting to send an electronic prescription if
the provider is not set up correctly.

Practice managers Admin/Reception

Clinicians IT

Electronic Prescribing (KB article)

Document Title: Jade to Saffron SP3 Upgrade Guide Version: Saffron SP3
Last Amended: 04 March 2022 Page | 24

https://kb.bpsoftware.net/bppremier/saffron/Clinical/PathologyandRadiology/SetupPathologyeOrdering.htm
https://kb.bpsoftware.net/bppremier/saffron/Clinical/PathologyandRadiology/SetupImagingeOrdering.htm
https://kb.bpsoftware.net/bppremier/saffron/Clinical/Prescribing/AddingCurrentRx.htm
https://kb.bpsoftware.net/bppremier/saffron/Clinical/PathologyandRadiology/MessagingProviders.htm
https://kb.bpsoftware.net/bppremier/saffron/Clinical/Prescribing/eScripts.htm
https://kb.bpsoftware.net/bppremier/saffron/Management/IHIRevalidation.htm
https://kb.bpsoftware.net/bppremier/saffron/Clinical/PathologyandRadiology/eOrdering.htm
https://kb.bpsoftware.net/bppremier/saffron/Clinical/Prescribing/eScripts.htm
https://kb.bpsoftware.net/bppremier/saffron/Clinical/Prescribing/eScripts.htm


Category Feature Who it affects / Resources

Electronic Prescribing – you can now send
electronic prescriptions using Medisecure.

Practice managers Admin/Reception

Clinicians IT

Electronic Prescribing (KB article)

Medicare refunds – partial refund options are
now available.

Practice managers Admin/Reception

Clinicians IT

Refund a Medicare payment (KB article)

Subpoena tool – you can now export data to
PDF.

Practice managers Admin/Reception

Clinicians IT

Subpoena tool (KB article)

Subpoena tool (QRG)

Cancellation list – you can add patients without
an appointment to the cancellation list.

Practice managers Admin/Reception

Clinicians IT

Rebook a patient from the cancellation list (KB article)

E-Ordering – You can now compete all your e-
ordering configuration through one screen.

Practice managers Admin/Reception

Clinicians IT

Set Up Pathology and Imaging E-Ordering in Saffron (KB
article)

Saffron SP2

Saffron SP2 includes Medicare Web Services functionality, plus a number of workflow changes and enhancements,
such as changes to the Follow up Inbox workflows, outgoing email improvements, and more.

Category Feature Who it affects / Resources

Medicare Web Services - Services Australia is
upgrading the technology used by Practice
management software that connects to Services
Australia for some digital health services. In
Saffron SP2, Medicare, DVA, and Concession
verification will use Medicare Web Services.
Online claiming and the Australian Immunisation
register will begin using Medicare Web Services
as of Saffron SP3.

Practice managers Admin/Reception

Clinicians IT

Medicare Web Services and PRODA (KB article)
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Category Feature Who it affects / Resources

Concession card verification - You can now
verify whether or not a patient is eligible for a
concession card via the patient demographic.

Practice managers Admin/Reception

Clinicians IT

Add a new patient (KB article)

Follow up Inbox - Saffron SP2 introduces the
ability to choose not to mark reports in the
follow-up inbox as Contacted, and introduces
the Attempts column for keeping track of the
number of times a contact attempt has been
made for a report.

Practice managers Admin/Reception

Clinicians IT

Marking results as contacted in the Follow up Inbox (KB
article)

Add AHPRA numbers to invoices - As of Saffron
SP2, an option for adding AHPRA numbers to
invoices is available under Setup >
Configuration > Billing.

Practice managers Admin/Reception

Clinicians IT

Add AHPRA to invoice templates (KB article)

Add a duration for once only prescriptions - As
of Saffron SP2, when prescribing medication
using the New Rx wizard in the patient record, if
Once only prescription is selected, you will have
the option to indicate the duration that the
medication should be taken for, or to indicate
that the medication should be taken until
finished. This information will be printed on the
prescription.

Practice managers Admin/Reception

Clinicians IT

Add or cease Rx (KB article)

Password workflow improvements - The Force
password change on next login checkbox has
been added to the New user and User details
screens, and is ticked by default in the New user
screen. When Force password change on next
login is ticked, the user will be required to
change their password when they next log into
Bp Premier.

Practice managers Admin/Reception

Clinicians IT

Add, update or deactivate a user (KB article)

Modified Monash category - As of Saffron SP2,
you can set your location's Modified Monash
Category via Setup > Practice details > Add.
Select the option applicable to your practice
location from the MM Location menu.

Practice managers Admin/Reception

Clinicians IT

Add practice location details (KB article)

Automatic Data Updates - As of Saffron SP2,
you can set up Data Updates to download and
apply automatically as they are released.

Practice managers Admin/Reception

Clinicians IT

Upgrade the drug database automatically (KB article)
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Category Feature Who it affects / Resources

Restore production data to a test server - You
can tick or untick a checkbox to indicate
whether or not the data is being restored to a
production server or to a test server. If you
indicate that the data is being restored to a test
server, production functionality will be disabled
on restore.

Practice managers Admin/Reception

Clinicians IT

Back up and restore Bp Premier (KB article)

Gender identity improvements - Pronoun fields
in the word processor now include the options
They, Their and Them, as well as He/She,
His/Her, and Him/Her, and the non-binary title
'Mx' has been added to the Title field in the New
patient or Edit patient screens

Practice managers Admin/Reception

Clinicians IT

Create a document template (KB article)

Add a new patient (KB article)

Visit types can be configured - All available visit
types display in Bp Premier by default. In Saffron
SP2, visit types can be removed if required.

Practice managers Admin/Reception

Clinicians IT

Configure visit types (KB article)

Business names can be added for individual
doctors - In Saffron SP2, the New user and Edit
user details screens include a Business name:
field.

Practice managers Admin/Reception

Clinicians IT

Add, update or deactivate a user (KB article)

DASS21 added to clinical functions - The
Depression, Anxiety and Stress Scale - 21 Items
(DASS21) are a set of three self-report scales
designed to measure the emotional states of
depression, anxiety and stress. In Saffron SP2,
the DASS21 has been added as an option under
Clinical in the patient record.

Practice managers Admin/Reception

Clinicians IT

Available clinical functions (KB article)

Three week recurring appointment interval -
You can now set the frequency for recurring
appointments to three weeks.

Practice managers Admin/Reception

Clinicians IT

Book a recurring appointment (KB article)

Online cardiovascular risk calculator - The
option to use the Australian Chronic Disease
Prevention Alliance's cardiovascular disease
calculator is available via Clinical >
Cardiovascular risk in the patient record. Click
Online CVD Check to open a browser window
displaying the calculator.

Practice managers Admin/Reception

Clinicians IT

Available clinical functions (KB article)
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Category Feature Who it affects / Resources

Document viewer - An improved Document
viewer has been included in Saffron SP2. The
new document viewer is faster and more robust
than the previous viewer.

Practice managers Admin/Reception

Clinicians IT

Document viewer (KB article )

Latest news section - The Latest News section
provides an easy method for accessing recent
information about Bp Premier, such as recent
updates and known issues, recent newsletter
articles, and tips and tricks.

Practice managers Admin/Reception

Clinicians IT

Bp Premier Latest News (KB article)

Outgoing email improvements - Saffron SP2
adds improved outgoing email functionality,
including the ability to send PIN-protected PDF
documents, and improved TLS encryption.

Practice managers Admin/Reception

Clinicians IT

Setting up Bp Premier to use email (KB article)

Saffron SP2 Rev1

Saffron SP2 Rev1 was a minor release containing a small number of bug fixes.

Saffron SP3

Saffron SP3 includes Online Claiming and AIR functionality delivered via Medicare Web services, improvements to
the immunisations workflow, the ability to view AIR data in Bp Premier and more.

Category Feature Who it affects / Resources

Send Immunisations to AIR from the
Immunisations screen - Individual
immunisations can be sent directly to the AIR
from the Immunisation screen in the patient
record. You are no longer required to send
immunisations to the AIR in bulk, however this
workflow is still available if required.

Practice managers Admin/Reception

Clinicians IT

Record and send immunisations to AIR (KB article)

Immunisations and sending to AIR (QRG)

Medicare Web Services - Online Claiming and
Australian Immunisation Register functionality is
now delivered via Medicare Web Services. You
must set up Medicare Web Services at your
practice to use online claiming and AIR
functionality in Saffron SP3.

Practice managers Admin/Reception

Clinicians IT

Medicare Web Services (KB article)
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Category Feature Who it affects / Resources

Hospital services claim changes - Each hospital
services batch must be made up of claims from
a single hospital. If you are creating a batch for
hospital services, a dropdown menu listing all
hospitals with vouchers to be processed will
appear, and you can select the hospital you wish
to create a batch for.

Practice managers Admin/Reception

Clinicians IT

Send a batch (KB article)

Medicare Web Services for clinical-only
practices - If your practice has a clinical-only Bp
Premier licence and you wish to use the
Australian Immunisation Register (AIR)
functionality available in Saffron SP3, you must
connect Bp Premier to Medicare Web Services.

Practice managers Admin/Reception

Clinicians IT

Connecting to Medicare Web Services for Clinical Only
Practices (KB article)

Direct bill claim numbers - Direct bill claim
numbers will reset to A0001 every day for each
provider. To search for a particular batch, use
the claim number in combination with the batch
date.

Practice managers Admin/Reception

Clinicians IT

Online Claiming: Direct Bill (KB article)

AIR provider numbers - If providers without
individual provider numbers require access to
send immunisations to the AIR and view AIR
data, you must add an AIR provider number for
the practice location via Setup > Practice details
> Practice locations > Edit.

Practice managers Admin/Reception

Clinicians IT

Access Australian Immunisation Register information (KB
article)

New statuses when performing a check for
payments - Depending on the claim's status
with Services Australia, the following alerts may
appear:

REPORT_NOT_FOUND
REPORT_NOT_READY
REPORT_NOT_AVAILABLE

Practice managers Admin/Reception

Clinicians IT

Check for payments (KB article)

Edit pendable patient claims - if a patient claim
requires further assessment by an operator, an
error will appear indicating that the claim has
been marked as pendable, and you will have the
opportunity to make adjustments to the invoice
before resending to Medicare.

Practice managers Admin/Reception

Clinicians IT

Invoice and claim (KB article)

Correlation ID numbers - The Correlation ID
column has been added to the Online Claiming
Screen in Saffron SP3. You may need to provide
the correlation ID to Medicare when contacting
them about a batch.

Practice managers Admin/Reception

Clinicians IT

Send a batch (KB article)
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Category Feature Who it affects / Resources

Record vaccinations given overseas - You can
now select Given overseas from the Billing
provider: field in the Immunisations screen to
record a vaccination that was not received in
Australia. The Country: field will be enabled, and
you can select the country that the vaccine was
received in.

Practice managers Admin/Reception

Clinicians IT

Record and send immunisations to the AIR (KB article)

New preventative health notifications -
Preventative health notifications for breast
cancer screening and bowel cancer screening
will display in the patient record for eligible
patients.

Practice managers Admin/Reception

Clinicians IT

Enable preventative health notifications (KB article)

Hyper links in Internal messages - You can add
hyper links into the body text of internal
messages.

Practice managers Admin/Reception

Clinicians IT

Send internal messages (KB article)

New user categories - the user categories
Contract Doctor and Registrar can be selected
from the Category: drop-down menu.

Practice managers Admin/Reception

Clinicians IT

Set up a Provider (KB article)

Access Australian Immunisation Register
information - Australian Immunisation Register
information can be accessed from Bp Premier
via the View AIR screen in the Immunisation
section of the patient record.

Practice managers Admin/Reception

Clinicians IT

Access Australian Immunisation Register Information (KB
article)
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